ELECTRONIC ARTS PRESENTS

CD-ROM CLASSICS
STRIKE COMMANDER™

EpilepsyWarning

PLEASE READ BEFORE USING THIS GAME OR ALLOWING YOUR CHILDREN TO USE IT.

Some people are susceptible to epileptic seizures or loss of consciousness when exposed to certain flashing

lights or light patterns in everyday life. Such people may have a seizure while watching television images or

playing certain games. This may happen even if the person has no medical history of epilepsy or has never had

any epileptic seizures.

If you or anyone in your family has ever had symptoms related to epilepsy (seizures or loss of consciousness)

when exposed to flashing lights, consult your doctor prior to playing.

We advise that parents should monitor the use of games by their children. If you or your child experience any

of the following symptoms: dizziness, blurred vision, eye or muscle twitches, loss of consciousness, disorienta-

tion, any involuntary movement or convulsion, while playing the game, IMMEDIATELY discontinue use

and consult your doctor.

PRECAUTIONS TO TAKE DURING USE

* Do not stand too close to the screen. Sit a good distance away from the screen, as far away as the length of
the cable allows.

* Preferably play the game on a small screen.

* Avoid playing if you are tired or have not had much sleep.

* Make sure that the room in which you are playing is well lit.

* Rest for at least 10 to 15 minutes per hour while playing a game.



This document contains all the information that you will need to get this game up and running. There are important
sections covering how to produce the necessary boot disk, how to install and run your game, a full key guide and
instructions on how to use the Adobe Acrobat on-line document reader.

For further information, the original manuals are provided "on-line" on the CD. these can be read using the included
Adobe Acrobat on-line document reader. To use this, see the section "Using the On-Line Documentation"

Finally, If you would like to order a printed version of the manuals, please see the order form on the back cover.

Introduction

Welcome to Strike Commander on CD. This guide tells you how to install your new game. If you have any dif-
ficulties, see Troubleshooting (pp. 8-11). To avoid compatibility or memory problems, please take a moment
to make sure that your system meets the

system requirements.

System Requirements
Computer. This game calls for an Intel486 or 100% compatible system.
Video Card. IBM VGA or compatible video card.
Free RAM. You must have at least 640K of base RAM (memory) to play Strike Commander. Of that 640K, at
least 557K (571,000 bytes) of base memory must be available at the DOS prompt to run the minimum game
configuration. You must also have at least 4§MB RAM, 2700K of that must be available.
If your CONFIG.SYS contains an EMS driver, you must have 2700K (2,765,000 bytes) of EMS memo-
ry available.
If your CONFIG.SYS does not have an EMS driver, you must have 2700K (2,765,000 bytes) of XMS
memory available.
Strike Commander won’t run with less than that. See Memory Requirements (p. 9) for more information.
Hard Disk. You must have a minimum of 2 megabytes free on your hard disk to install and play Strike
Commander CD.
CD-ROM. MS-DOS CD-ROM extensions 2.1 or higher are required; a CD drive with 350ms or faster seek

time is recommended.



Be sure to check out our Strike Commander Playtesters’ Guide!
(See the on-disk ORIGIN catalogue for details.)
Documentation and a preview of new EA titles are provided on-disk.
If you would like to receive the printed manual, please see the order form on the back cover.

On-Line Help

Press for on-line help during installation.

Quick Install

) b Insert the CD-ROM (label side up) into your CD-ROM drive.
2 Change to your CD-ROM drive.

3. Type INSTALL.
4

Follow the instructions at each prompt.

Installation

When presented with a menu, press (1) and (3] to move through the list, then press to accept the high-

lighted selection. You may abort the installation process by pressing or selecting the ABORT menu option.

| & Insert the CD-ROM (label side up) into your CD-ROM drive. Some drives may require that you put
the disk into a CD caddy before inserting it in the drive.

2. Change to your CD-ROM drive by typing the letter of the drive and a colon, then pressing (Enter).

3 Type INSTALL.

4. The program prompts you for the letter of the hard drive to which you want your system configuration
data and saved games written. Press the letter on your keyboard corresponding to a hard disk with ade-
quate space. If you specify an invalid drive, the program will prompt you again.

x You are prompted for the sound card you are going to use for music. If you do not have a sound card,
you can select NOTHING. Your choices are:



NOTHING ANY SOUND BLASTER

AD LIB WAVE BLASTER
ROLAND / LAPC-1 PRO AUDIO SPECTRUM
GENERAL MIDI ABORT INSTALLATION

You are asked for the sound card to use for digital effects. If you do not have a sound card, you can
select NOTHING. Your choices are:

NOTHING SOUND BLASTER PRO

SOUND BLASTER PRO AUDIO SPECTRUM

ABORT INSTALLATION
If you select any of the Blaster cards (SOUND BLASTER, WAVE BLASTER, etc.), you are prompted for the
Base 1/O and IRQ settings of the card. The install program will initially highlight the default values for
these; if you have changed either your cards 1/0 or its IRQ, select the correct value(s) and press (Enter].
Note that older Sound Blaster cards have a default IRQ of 7 (rather than 5). Use () and (¥] to highlight
each appropriate selection, then press (Enter].

You are asked if your system is equipped with a local bus video card. If it is, choose this option for a
slight improvement in performance. (If you do not have a local bus video card, choosing this option
slows performance.)

You are given several installation options at this point. You must always install the primary executable
and the current game map, so this is not given as an option. These basic files take less than 2 megs of
hard drive space.

In addition, you may copy two more sets of files from the CD to your hard drive. Generally, the more
files you can store on your hard drive, the faster the game will run. The drawback is that you use more
space on your hard drive. Select the installation method that works best for you. The two sets of addi-
tional files, along with how much space they would occupy on your hard drive and which systems we

recommend them for are:

OPTION HARD DRIVE SPACE OPTIMAL FOR
COPY ADDITIONAL EXECUTABLES 2 MEGS SINGLE SPEED CD DRIVES
COPY TREE 9 MEGS 4 MEGS RAM

4



Players using double speed CD drives and who have at least 8 megs of RAM might notice slight

improvement in performance by copying these additional files to their hard drives.

Of course, it is possible to transfer both sets of additional files. This combination (including basic files)
occupies less than 12 megs on your hard drive and is recommended for players with single speed CD
drives and only 4 megs of RAM.

Note: It is possible to transfer all files from the CD to your hard drive, but this is not given as an option
because doing so fills over 150 megs on your hard drive. If that is really how you want to play the game,
install the basic executables using any option given above. Then go to you CD drive prompt, and type:

xcory ** c:\(Strike directory)
This will take quite a while, and we definitely do not recommend it.
10.  The install program copies files to your hard drive.

11.  When the installation is complete and you are ready to play, go to the Strike directory on your hard
drive. (If you accepted our default suggestion, this directory is SC.) Type SCCD to get a menu of games,
and select the game you want to play (STRIKE COMMANDER or TACTICAL OPERATIONS) from this menu.

Changing Your Configuration

If you ever add a sound card or change from one card to another, simply re-run the installation program from
your hard drive. (You would re-run the install program from the CD only ify()u were totally replacing the game.)

Re-Installing

Should you find it necessary to re-install Strike Commander, we recommend that you first delete all the files in
the Strike Commander directory except any files with the .SAV or .TO1 extensions (these are your Strike
Commander and Tactical Operations saved games, respectively). The install process will not write over them.



Using the On-Line Documentation
DOS USERS:

System requirements for DOS:
386- or 486-based PC (486 recommended), DOS 3.3 or higher
2 MB of available RAM (4 MB or more recommended)
4 MB hard disk space
Microsoft-compatible mouse
VGA graphics
CD-ROM drive

Postscript or LaserJet printer supported
To install the DOS Adobe Acrobat on-line document reader:

NoTE: If you have Microsoft® Windows™ installed, we recommend that you install the Windows ver-
sion of the Adobe Acrobat reader for greater ease of use when reading the on-line manuals. See below
for instructions on installing Acrobat for Windows.

Note: If you have already installed the Acrobat reader from another CD ROM Classics title, it does not
need to be re-installed—skip to the 7o Start Adobe Acrobat for DOS or To Start Adobe Acrobat for
Windows section.

Insert the CD in your CD drive.
Type d: (or the letter of your CD drive, if different) and press .J (ENTER) to move to the CD drive.
When you see the “D:” prompt, type installa .

h PN =

The installation menu appears. Follow the menu prompts to install the on-line documentation
reader.
*  To highlight a menu item, press the arrow cursor keys up/down.

*  Toactivate the highlighted item, press .J.



To start Adobe Acrobat for DOS:\
1. The CD must be in the drive to run the program.
2. Move to the directory where Adobe Acrobat is installed. By default, it is installed in C:AACROBAT,
so you would type:
cd
od \acrobat .J
3. Type acrobat I to start the program.
NOTE: If you receive an “ACROBAT.INI” error message when running Acrobat, see Creating a DOS
Boot Disk below.

WINDOWS USERS:

System requirements for Windows:

386-or 486-based PC (486 recommended)
4 MB RAM
Microsoft Windows 3.1 or greater
CD-ROM drive
To install Adobe Acrobat for Windows:
1. Insert the CD in your CD drive. The CD must be in the drive to install and run the program.
2. Start Windows.
3. From the Windows Program Manager, choose RUN... from the File menu. The Run dialog box
appears.
4. Type d:\acroread.exe. (If your CD-ROM isn’t drive D:, substitute the appropriate letter for ‘d’.)
5. Click OK or press ENTER and follow the instructions on your screen.
To start Adobe Acrobat for Windows:
1. Start Windows and ensure that the CD is in the drive.
2. Ifthe Acrobat Reader 2.0 icon is not visible in the Program Manager window, double-click on the
Acrobat program group icon. The Acrobat window opens.
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Double-click the Acrobat Reader 2.0 icon. The program begins.

To open a document file (DOS and Windows):

Select Open from the File menu. Use the FILENAME dialog box to select the directory of the file
(The on-line documents are in the \DOCS directory on the CD).

Type d:\docs\English (or appropriate CD drive letter). Double-click on a file to open it. The files are:

ADDENDUM.PDF
BIB.PDF
MANUAL.PDF
SUDDEN.PDF
TACTICAL.PDF

To print a document file:

Select PRINT from the File menu. Choose the range you want to print from the Print Range dia-
log box.

If you receive a “Acrobat does not support printing at this device resolution...” message, increase the
resolution in the Print Quality dialog box.

In DOS, prior to printing, go into PRINT SETUP from the File menu. Choose Bitmap, which will
provide a list of available printer devices.

The Adobe Acrobat Document Reader does not support 9-pin printers.

To learn how to use Adobe Acrobat:

Open the file HELPREAD.PDF in the \DOCS directory on the CD. Complete Acrobat instruc-
tions are contained in this file.

Quick Acrobat Tips:

If you have difficulty viewing documents, click on the magnifying glass icon on the bottom of the
screen to increase resolution.

Each document file contains bookmarks that function as an electronic table of contents. To view
bookmarks, select Bookmarks and Page from the View menu. The bookmarks appear to the left of
the document window.



*  To jump to the page associated with a bookmark, double-click on the page icon next to the book-
mark.

¢ To show or hide any subordinate bookmarks, click the triangle to the left of bookmark.

*  To move through the document one page at a time click the Previous or Next Page buttons or press
the left/right arrow cursor keys.

*  To move through a document one screen at a time, click above or below the scroll box in the scroll
bar or press the PAGE Up/PAGE DOWN keys.

Optimising Your System

Memory Requirements

We have tried to minimise the amount of time you spend configuring the memory in your system, but Strike
Commander is the most memory-intensive game in ORIGIN’s history, and adjustments to your memory con-
figuration may be needed.

There are three types of RAM referred to in this manual: DOS (conventional base RAM), extended and
expanded. Strike Commander has specific minimum requirements for each of these types of memory. If you
are unsure about these different types of memory, consult your DOS manual.

To find out how much DOS, extended and expanded memory your computer has available, type MEM at the
DOS prompt. When the memory information is printed on the screen, look for the following listings:

LARGEST EXECUTABLE PROGRAM SIZE

LARGEST AVAILABLE UPPER MEMORY BLOCK

TOTAL EXTENDED OR XMS

BYTES FREE OF XMS

BYT AVAILABLE XMS

BYTES FREE OF EMS

FREE EXPANDED (EMS)
The Largest Executable Program Size should be at least 557K. (Actually, it can be as small as 527K, if the
Largest Available Upper Memory Block is at least 30K.)




You will have only one of the last five listings — Total Extended or XMS / Bytes Free of XMS / Bytes avail-
able XMS / Bytes Free of EMS / Free Expanded (EMS) —

partially depending on whether or not you have an EMS driver. Regardless of which

listing you have, it should show at least 2700K available.

If you are experiencing problems installing or running Strike Commander, it might help to create a separate
boot disk or decrease the number of memory-resident programs (TSRs) you have loaded with the suggested
configurations listed below.

Do not delete your AUTOEXEC.BAT or CONFIG.SYS files completely, or alter them on your hard drive

— without them, your computer will not function.

Creating a DOS Boot Disk

Before you proceed, you should print out the contents of your AUTOEXEC.BAT and CONFIG.SYS files. If
you do not have a printer, copy the contents by hand or make backups of the files that you can look at later.
To print, at the DOS prompt, type:

TYPE CONFIG.SYS
Use to generate a printout of this startup file. Next (while still at the DOS prompt), type:

TYPE AUTOEXEC.BAT
Use to generate a printout of this startup file, also.

To create a separate boot disk:
1. Inserta blank high density disk in your A: drive. From the DOS C: prompt, type:
FORMAT A: /$
2. . When the DOS prompt returns and the format is complete, type:
EDIT A:\CONFIG.SYS
When the new screen appears, type the commands shown below. This configuration is generic and may
require additional drivers. Consult your CD-ROM manual for more information.

CONFIG.SYS USING EMM386.EXE (EMS WITH DOS 5.0, 6.0, 6.2, WINDOWS 3.1)
DEVIC \DOS\HIMEM.SYS
DEVICE=C:\DOS\EMM386.EXE 3072 RAM /1=B000-B7FF

10




Use the previous line only for 4-meg systems.
DEVICE=C:\DOS\EMM386.EXE 7168 RAM /1=B000-B7FF
Use the previous line only for 8-meg (or larger) systems.
Do not include NOEMS in either of the two previous lines.
DOS=UMB
DOS=HIGH

BUFFERS=30
SHELL=C:\DOS\COMMAND.COM C:\DOS /P
DEVICEHIGH=C: \(drivers)
Add your CD-ROM driver(s) to the previous line just as they appear in your
original hard drive CONFIG.SYS.
DEVICE=C:\MOUSE\MOUSE.SYS
You may need to adjust the path in the previous line, depending on the location of your mouse driver.
DEVICE=C:\DOS\DBLSPACE.SYS /MOVE
Include the previous line only if you are using DoubleSpace with DOS 6.0 or 6.2.

Exit and save this file by pressing:

If you are running under EMM386, you can load other device drivers into high memory with the DEVICE-
HIGH command.

CONFIG.SYS USING QEMM 6.0, 6.02 OR 7.0 (EMS)
DEVICE=C:\QEMM\QEMM386.5YS RAM
DOS=HIGH

"E=C:\QEMM\LOADHLSYS C:\DOS\DBLSPACE.SYS /MOVE
Include the previous line only if you are using DoubleSpace with DOS 6.0 or 6.2.
DEVICE=C:\QEMM\LOADHLSYS C:\(drivers)
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Add your CD-ROM driver(s) to the previous line just as they appear in your

original hard drive CONFIG.SYS.
DEVICE=C:\QEMM\LOADHLSYS C:\MOUSE\MOUSE.SYS

You may need to adjust the path in the previous line, depending on the location of your mouse driver.
SHELL=C:\DOS\COMMAND.COM C:\DOS /D

Exit and save this file by pressing:

If you are using QEMM, you can also use the Optimise program to optimise your system setup. See your

QEMM documentation for more information.

CONFIG.SYS USING HIMEM.SYS (XMS WITH DOS 5.0, 6.0, 6.2, WINDOWS 3.1)

DEVICE=C:\DOS\HIMEM.SYS

DOS=HIGH

FILES=30

BUFFERS=30

SHELL=C:\DOS\COMMAND.COM C:\DOS /P

DEVICE=C: \(drivers)
Add your CD-ROM driver(s) to the previous line just as they appear in your
original hard drive CONFIG.SYS.

DEVICE=C:\MOUSE\MOUSE.SYS

You may need to adjust the path in the previous line, depending on the location of your mouse driver.

Exit and save this file by pressing:

Note that an XMS boot disk needs only 527K base RAM free to run Strike Commander CD, rather than
557K. However, if you're using DoubleSpace, you may not be able to free enough base RAM to play. Note
that the XMS CONFIG.SYS we recommend does not use DoubleSpace.

ACROBAT NOTE: If you receive any “ACROBAT.INI” error messages from the DOS Acrobat document reader pro-
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gram, modify the following lines in the CONFIG.SYS file on your boot disk:
FILES=30
BUFFERS=30
AUTOEXEC.BAT
You will also need an AUTOEXEC.BAT file on your boot disk. To create one, type:
EDIT A:\AUTOEXEC.BAT
When the new screen appears, type:
PROMPT $P$G
PATH=C:\DOS
SET COMSPEC=C:\DOS\COMMAND.COM
C:
C:\(path)\MSCDEX.EXE (all parameters from the original AUTOEXEC.BAT)
If you do not have 557 base RAM free, try changing IM:## to IM:5 in the
previous line.
LH C:\MOUSE\MOUSE.COM
Your mouse driver may need to be loaded differently. For example, if it is loaded in your CONFIG.SYS, do
not include this line in your AUTOEXEC.BAT. Refer to the printout of your original AUTOEXEC.BAT to see if it is
normally loaded there.

Exit and save this file by pressing:

SUPPORTING YOUR PERIPHERALS

You may need to add lines to the basic boot disk CONFIG.SYS and AUTOEXEC.BAT for Strike
Commander to support certain sound cards, game cards and other hardware. Consult your documentation for
these products.
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Using Your Boot Disk
1.

Turn your computer off, insert your new boot disk in your A: drive and turn the computer back on.
(If your CD drive is external, turn it on.)

2. Insert the CD-ROM disk (label side up) into your CD-ROM drive. (Some drives may require that
you put the disk into a CD caddy before inserting it in the drive itself)

3a. Ifyou haven’t yet installed the game, change to your CD-ROM drive by typing its drive letter fol-
lowed by a colon (e.g., d:) and pressing (Enter), then continue from Step 3 in Installation (p. 3).

3b. If you've already installed the game and you are ready to play, go to the game directory on your hard
drive. (If you accepted our default suggestion, this directory is SC.) Type SCCD to get a menu of
games, and select the game you want to play (STRIKE COMMANDER or TACTICAL OPERATIONS) from
this menu.

Caching
Strike Commander uses all available memory for its own internal disk caching. Adding SmartDrive or any
other caching utility may actually slow disk access.

I/0 and IRQ

If the install program reports difficulty finding your sound card, check to make sure you've selected the cor-
rect I/O and IRQ. Consult your sound card documentation if you continue to have difficulties.

Troubleshooting

Occasionally, something will go wrong with the installation process. Common error messages are given below,
along with some solutions.

Online Help. Some of this information is included in the install program’s on-line help feature, which can be
accessed at any point during installation by pressing (F1_).
Messages During Installation

The version of DOS on your machine is too old to run Strike Commander.
You need DOS version 5.0 or higher. New versions of DOS can be purchased at almost any computer dealership.
Strike Commander has been fully tested with versions 5.0, 6.0 and 6.2.
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The CPU detected on this machine is not compatible with Strike Commander. You need an 80386 or bet-

ter to install and play Strike Commander.

Strike Commander requires a computer with an 80386 or better CPU. Older CPUs do not have the processing
power required to play Strike Commander — they can not run the game. (Some players with 386 CPUs are sat-
isfied with Strike’s performance on their systems, but most are not. We recommend that you use at least a 486.)

If you do not have one of these CPUs, you will need a CPU upgrade in order to play Strike Commander. 1f
you do have a 386 or better and receive this error message, try installing again from the beginning,. If you still
receive this message there may be a defect in your processor.

Could not copy files from the CD to the hard drive.

Although this could mean that your drive is malfunctioning, the most common cause of this message is a read
error. Check to make sure the CD is properly inserted in the drive and that the drive is closed completely,
then try installing again.

One of the configuration files either could not be located, or could not be created.
An error has been detected with an install configuration file. This usually means one of two things has occurred:

(1) A file needed by the install program to properly determine your computer’s configuration was not found.
The file could have been damaged, deleted or moved, or the directory structure of your machine could have
been altered since the last installation.

(2) The install program was unable to write a configuration file. The hard disk could be full or could contain
undetected errors. Another possibility is that your computer has a memory problem that is stopping the instal-
lation. See Optimising Your System (p. 9) to remedy this situation.

Make sure you are in the directory in which Strike Commander was previously installed, or in the directory
where the install program is.

Could not find treefile.

This means that one of the files necessary to run the game was not available. There are a number of possible
causes for this error, including:

* The CD-ROM is not loaded in the drive correctly.

e The CD-ROM drivers are not installed correctly or have been incorrectly modified.

* The hard disk where the installed game is located could not be found.
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Make sure that all game files on your hard drive are located in the game directory. If this problem persists,
awempt reinstalling Strike Commander CD-ROM. If this does not fix the error, please contact ORIGIN
Product Support (see below).

Could not create the Strike Commander directory.

A file exists with the same name as the directory, the drive may not have enough free space, or you have
attempted to install to a disk that is set to read only. The latter should only be a problem if you are loading
onto or with a network.

We do not recommend loading Strike Commander while network drivers are loaded.

Troubleshooting During Play
My mouse is not working with Strike Commander CD. My mouse works with all of my other software
applications — why not with Strike Commander:
If your mouse is not working with Strike Commander, you should first check to see if your mouse has been loaded in
DOS (in your AUTOEXEC.BA T file) or onto the boot disk JYou are using to play the game. Windows and many
other “multi-tasking” environments load their own built-in mouse driver. These mouse drivers will not oper-
ate outside of their shell environment. Loading a mouse driver into the DOS environment can be as simple as
typing MOUSE at the command prompt. For example:
C:\MOUSE

This command can differ depending on which mouse driver software you are using. Please consult your
mouse user’s guide for further details.
You may also experience trouble running Strike Commander with a non-Microsoft (or 100% compatible) mouse
driver. If you do, any of the following steps should fix the problem:

L. Replace the mouse driver with a Microsoft mouse driver.

2. Disconnect your mouse and use your keyboard or joystick instead.

3. Remove the mouse driver and use your keyboard or joystick instead.

Why do I get the message: “Sound System Initialisation Failed”?

You probably have enough memory to run the game, but not enough to load the sound drivers you selected during
installation. You will either have to increase the amount of free DOS memory (see Optimising Your System,
p. 9) or play without sound.

or If your sound card is not one of the cards listed on the box or in the installation program, but is 100% compatible with
one of the cards listed, it may need to be configured for Sound Blaster emulation mode. Consult your sound card manual.
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When I start, the music sounds very odd on my Sound Blaster Pro.

Early versions of the Sound Blaster Pro require different configurations than later versions. To correct this, run the
SET-ENV program that came with your Sound Blaster Pro. This will automatically set the environment vari-
able properly. If this doesn’t work, this variable can be set manually. Consult your Sound Blaster Pro docu-
mentation or your hardware dealer for more information.

I don’t have a digital sound card, so I selected SOUND FX (AUDIO Option Screen). However, |
can’t hear the engine. What’s wrong?

Without digital sound effects, Strike Commander cannot simultaneously run both music and engine noise. 1f you
want to hear the engine noise, turn MUSIC off.

I am having trouble using my joystick.

* Your joystick may be set to “auto fire.” If this is the case, the buttons may not function as you expect. To
correct the problem, turn auto fire off. If your joystick doesn’t allow you to turn auto fire off, unplug it and
play with a mouse or use the keyboard controls.

« In the event that you experience any joystick calibration problems, be sure that you don’t have more than one
active gameport on your system at any time, as they will conflict with Strike Commander’s calibration routine and
will affect game performance. This includes gameports present on sound cards, gamecards or I/O cards. You may
need to consult the documentation for your system, sound card and game card to resolve any problems.

+ Ifyou are using a multi-speed gamecard, be sure that you have performed the software or speed dials tests
for your particular gamecard. If you continue to have problems, try adjusting the speed-dial or numeric soft-
ware settings a little higher or lower than normal. On cards like the Gravis Eliminator game card, we found
settings between 4.0 and 5.5 to be well suited for Srike Commander. For other cards, please check your game
card documentation to configure the card for different speed settings. If the problem persists, you may have a
defective joystick or gameport.

Why does my computer lock up or give me “run time” errors?

On some machines, the CD-ROM drive may be daisy-chained with several other drives on a cable from the
SCSI controller card. Because this game needs to have simultaneous access to both the hard drive and the CD-
ROM drive, it cannot run on a CD drive that is daisy-chained with other drives. We strongly recommend
that Strike be installed to a drive that is 707 on the same cable as your CD-ROM drive.
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I've got 16 (or more) megs of RAM and a digitized sound card, so I shouldn’t be having any
problems, but speech in the game is full of static.

Because direct memory access (DMA) will not work with memory addresses above 16 megabytes, the digitized speech
of Strike Commander may not work correctly on machines with large amounts of memory. If you hear static in the
game when speech would be more appropriate, then this problem could be occurring.

The best solution is to remove your memory manager and let the game supply the high memory using its own
m(:mnry managcr.

See Optimising Your System (p. 9) for more details on memory configuration.

Ive got a digital sound card, and I've turned on DIGITAL EX, but I still sometimes get undigitised
sound effects.

With DIGITAL FX turned on, you may run into instances where you will get non-digitized sound effects. This
will happen if a digital effect is supposed to be played at the same time as another digital effect. The chip used
by most sound cards to produce digitized sound and effects can only play one digitized effect at a time.

When I try to start a new game, it crashes to DOS and gives me Error Code #1910 or #1941.
This is caused by a bad installation or a corrupted file on the original installation. To determine which is the case,
boot from a clean configuration that does not load other conflicting device drivers such as a disk cache. See
Optimising Your System (p. 9) for more information on the proper configuration. Next, delete all files from
the Strike Commander directory (default: C:\SC). Finally, re-install Strike Commander and Tactical Operations
(while booted from the clean configuration).

Specific Hardware and Software

DoubleSpace
Strike Commander has been fully tested with MS-DOS 6.0’s DoubleSpace disk compression utility. We cannot

guarantee the compatibility of our games with other disk compression utilities. You might want to add the fol-

lowing line to your CONFIG.SYS file to free more DOS RAM (base memory):
DEVICEHIGH=C:\DOS\DBLSPACE.SYS /MOVE

Thrustmaster Weapon Control System

The DIP switch settings on the Weapon Control System for Strike Commander are switches 1, 2 and 6 on. All

other switches should be off.
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CH GameCard III Automatic
The CH GameCard IIT Automatic requires a program to be run whenever the machine boots up. This pro-
gram is called CHJOY3.EXE. Please be sure that this program runs before calibrating joysticks in Strike
Commander, or unpredictable results will occur. You may want to add the following line at the end of your
AUTOEXEC.BAT:

CHJOY3.EXE

DOS 5.0 SMARTDRV.SYS
Strike Commander does not support the SMARTDRV.SYS that comes with some versions of DOS. It does sup-

port SMARTDRV.EXE which comes with Windows 3.0 or better.

Bus Mastering Hard Drive Users
If you're using a bus mastering hard drive controller card (you'll probably know if you are), and if the game text
and graphics are garbled, add the following line to your CONFIG.SYS:

DEVICE=C:\DOS\SMARTDRV.EXE /DOUBLE_BUFFER

SB16/Wave Blaster and CH Flightstick Combination

Due to a hardware conflict between the joystick port on the Creative Labs’ SB16/Wave Blaster combination and
the CH Flightstick, General MIDI music will not be heard when the Flightstick is connected to the SB16/Wave
Blaster joystick port. Another manufacturer’s joystick or another joystick port must be used to receive the
General MIDI music. Contact the respective manufacturers if you have any further compatibility questions.

General MIDI

Strike Commander CD has joined the next generation of sound quality with its support of the General MIDI
standard as defined by the MPU-401 instruction set. At the time of publishing, only a few cards support
MPU-401. These cards include the Roland SCC-1 and RAP-10 and the Creative Labs Sound Blaster 16 and
ASP 16 (both of the latter with the attached Wave Blaster daughterboard). Other manufacturers have already
released, or are planning to release, sound cards that use the MPU-401 instruction set. However, sound cards
that use a memory-resident program (TSR) to emulate MPU-401 may not work with this software.

Note that some General MIDI cards offer digitized speech or sound effect capabilities. Strike Commander CD
will only use those sound cards that carry the OPL2 FM chip for digitized speech or sound effects. As in the
case of the Roland RAP-10, customers will need to use a second sound card, such as a Sound Blaster, Sound
Blaster Pro or 100% compatible sound card, for digitized speech and effects. Review your sound card docu-
mentation or contact the manufacturer if you have any questions.
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Strike Commander Reference Card

Keyboard Flight Controls

WEAPONS

[72]
=
=

FEEEGHO

Drop flare
Drop chaff
Dogfight mode (“Guns”)

Select next farther target

g 8
2 6

o Ct
Select next closer target

Shift

8

Select no target

Track selected target
(from cockpit only)

NAVIGATION AND MANOEUVRING

@-E
-0

8]

Military (normal) engine power 8
in 20% increments
Afterburner power in 20% >

increments

Step up engine power

(+)
ofolc

S[Cp down cnginc power

20

Fire selected weapon
Select next weapon

Show loadout
(memory permitting)

Jettison selected weapon

Jettison all air-to-ground
weapons

Engine shutoff
Flight control (pitch and roll)

Left rudder (also (}))
Right rudder (also (1))



Brakes on/off (toggle; air or wheel brakes depending on location)
Flaps up / down (toggle)
Landing gear up /down (toggle)
Autopilot to waypoint, auto-takeoff, or auto-landing
Navigation map
Calibrated / True airspeed (toggle)
CtrlJE] Eject
MULTI-FUNCTION DISPLAYS

Communication systems

Inaaﬂaa

©
EJ

Radar (mode depends on selected
weapon)

(D) Damage control and fuel

Gl ) o MED AA radar single target track

s
B®

Zoom in, out (radar)

CAMERA VIEWS

Pan around cockpit
(if enabled at option screens)

View ground targets (cycles
through ground targets)

Player to target /
target to player (toggle)

Gun camera (MFD)

Cockpit camera (front view)
Chase camera
Left, right and back

cockpit cameras Victim camera

Q
=
7| (M (M m m
2| || | ~ o

External camera
(cycles through air targets)

(Ctrl] 1] Invisible cockpit (on/off)

Weapon camera

Zoom in, out

=
=
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Other Flight Controls

THRUSTMASTER WEAPON CONTROL SYSTEM
Main unit......... Throttle control ~ Switch 4.......... Weapon select ~ Switch 7a........ AA/AG Radar

Switch 1.......... Flare Switch 5.......... Flaps Switch 7b........ (no function)
Switch 2.......... Chaff Switch 6.......... Brakes Switch 7c........ Dogfight toggle
Switch 3.......... Target select

THRUSTMASTER FLIGHT CONTROL SYSTEM
Main joystick........ Flight control

Top joystick.......... Pan around cockpit (if enabled at option screens)
Trigger.....cc0ssisneesee Fire selected weapon

Top button........... Select weapon (if no WCS) or Return to cockpit view

Mid button...........Select target

Low button........... Return to forward cockpit view

JOYSTICK CONTROL

Joystick........cco000i Flight control

Button 1 ............... Fire selected weapon

Button 2........0004.4 Pan around cockpit (move joystick while button is pressed)
FLIGHTSTICK PRO JOYSTICK CONTROL

Left button ........... Select weapon Right button......... Select target
Low button........... Return to forward cockpit view Coolie hat............. Pan around cockpit
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MOUSE CONTROL

Mouse o Sig i Flight control (if no joystick active)

Left button ........... Fire selected weapon

Right button.

.Pan around cockpit

Game Interface

Recalibrate joystick

Music on / off (toggle)

Game options (detail level,
difficulty, etc)
Pause

(At [P)
Sound on / off (toggle)

Engine sound on/off toggle

TECHNICAL SUPPORT
If, after thoroughly reviewing ALL the documentation, you are still hay-
ing a problem with this software, please read the following section.
Electronic Arts has a staff of customer service technicians ready to help
you with any problems you may encounter with the game. Electronic Arts
Customer Service is available Monday to Friday during normal business
hours on (01753) 546465.

Today’s PCs run with millions of different hardware and software combi-
nations. Because of this, you may also have to refer to your computer
dealer o hardware manufacturer in order to properly configure their
product to run with our game.

When you call, if at all possible, be near your computer. If it is not possi-
ble, make sure you have the following information ready:

* The error message displayed when the problem occurred (if any).

+  Alisting of your machine type and hardware contents, including
CPU, sound and video board details.

The DOS version number you are currently running.

(Alt [ XJExit to DOS without saving

Time compression: 1x, 2x, 4x
(sustained)

Time burst 6x (lasts while

(1) is held)

Move the cursor

* Your mouse and driver type.

*  The contents of your CONFIG.SYS and AUTOEXEC.BAT files.

*  Your CD-ROM drive type and CD-ROM extensions version, if fitted.
+  The contents of a CHKDSK and MEM/C statement.

Or you may write to us at the following address, including a daytime tele-
phone number and the above information.

Electronic Arts Customer Service,

P.O. Box 835, Slough, Berkshire, England SL3 8XU



NOTICE

ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE IMPROVEMENTS
IN THIS PRODUCT DESCRIBED IN THIS MANUAL AT ANY TIME AND
WITHOUT NOTICE.

THIS MANUAL, AND THE SOFTWARE DESCRIBED IN THIS MANUAL,
1S UNDER COPYRIGHT. ALL RIGHTS ARE RESERVED. NO PART OF
THIS MANUAL OR THE DESCRIBED SOFTWARE MAY BE COPIED,
REPRODUCED, TRANSLATED OR REDUCED TO ANY ELECTRONIC
MEDIUM OR MACHINE-READABLE FORM WITHOUT THE PRIOR
WRITTEN CONSENT OF ELECTRONIC ARTS LIMITED, 9 HERON
DRIVE, LANGLEY, BERKS SL3 8XP, ENGLAND.

ELECTRONIC ARTS MAKES NO WARRANTIES, CONDITIONS OR REP-
RESENTATIONS EXPRESS OR IMPLIED, WITH RESPECT TO THIS MAN-
UAL, ITS QUALITY, MERCHANTABILITY OR FITNESS FOR ANY PARTIC
ULAR PURPOSE. THIS MANUAL IS PROVIDED “AS IS”. ELECTRONIC
ARTS MAKES CERTAIN LIMITED WARRANTIES WITH RESPECT TO
THE SOFTWARE AND THE MEDIA FOR THE SOFTWARE. IN NO
EVENT SHALL ELECTRONIC ARTS BE LIABLE FOR ANY SPECIAL, INDI
RECT OR CONSEQUENTIAL DAMAGES.

THESE TERMS AND CONDITIONS DO NOT AFFECT OR PREJUDICE
THE STATUTORY RIGHTS OF A PURCHASER IN ANY CASE WHERE A

PURCHASER IS A CONSUMER ACQUIRING GOODS OTHERWISE
THAN IN THE COURSE OF A BUSINESS.

LIMITED WARRANTY

Electronic Arts warrants to the original purchaser of this computer software
product that the recording media on which the software programs are record-
ed will be free from defects in materials and workmanship for 90 days from
the date of purchase. During such period defective media will be replaced if
the original product is returned to Electronic Arts at the address on the rear of
this document, together with a dated proof of purchase, a statement describ-
ing the defects, the faulty media and your return address. This warranty is in
addition to, and does not affect your statutory rights in any way.

“This warranty does not apply to the software programs themselves, which
are provided “as is”, nor does it apply to media which has been subject to

misuse, damage or excessive wear.

©1993 ORIGIN Systems, Inc. Strike Commander and Tactical
Operations are trademarks of ORIGIN Systmems, Inc. Origin and We
Create Worlds are registered trademarks of ORIGIN Systems, Inc.
Electronic Arts is a registered trademark of Electronic Arts.

To order the printed manual and reference card, please send this form and a Eurocheque for £2.50 to:

Electronic Arts Customer Services
P.O. Box 835,Slough, Berkshire
ENGLAND

SL3 8XU

Attn: CD Classic Manuals

Name

Address

County Postcode Country
STRIKE COMMANDER™

If you need to contact us regarding the documentation, please call us at 01753 546465
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